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Important information for your
interactive flat panel

N WARNING

o Failure to follow the installation instructions sent with your SMART product could result
in personal injury and product damage which may not be covered by your warranty.

o Do not open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

o Do not stand (or allow children to stand) on a chair to touch the surface of your SMART
product. Rather, mount the product at the appropriate height.

o Toreduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

o If your SMART product requires replacement parts, make sure that the service
technician uses replacement parts specified by SMART Technologies or parts with the
same characteristics as the original.

o Ensure that any cables extending across the floor to your SMART product are properly
bundled and marked to avoid a trip hazard.

« Do notinsert objects inside the cabinet ventilation holes, because they could touch
dangerous voltage points and cause electric shock, fire or product damage which may
not be covered by your warranty.

o Do not place any heavy objects on the power cable. Damage to the cable could cause
shock, fire or product damage which may not be covered by your warranty.

o Use only extension cords and sockets into which this product’s polarised plug can be
fully inserted.

o Use the power cable provided with this product. If a power cable is not supplied with this
product, please contact your supplier. Use only power cables that match the AC voltage
of the power outlet and that comply with your country’s safety standards.

o If the glass is broken, do not touch the liquid crystal. To prevent injury, handle glass
fragments with care when disposing of them.

o Do not move or mount the interactive flat panel by connecting rope or wire to its handles.
Because the interactive flat panel is heavy, rope, wire or handle failure could lead to
personal injury.

o Use only VESA®-approved mounting hardware.



IMPORTANT INFORMATION FOR YOUR INTERACTIVE FLAT PANEL

o Disconnect all power cables for your interactive flat panel from the wall socket and seek

assistance from qualified service personnel when any of the following occurs:
o The power cable or plug is damaged

o Liquid is spilled into the interactive flat panel
o Objects fall into the interactive flat panel

o The interactive flat panel is dropped

o Structural damage such as cracking occurs

o The interactive flat panel behaves unexpectedly when you follow operating
instructions

CAUTION

o Before you clean your SMART product, shut down or disconnect the computer.

Otherwise, you may scramble the desktop icons or inadvertently activate applications
when you wipe the screen.

Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.

Make sure that an electrical socket is near your SMART product and remains easily
accessible during use.

For SMART Board 8055ie-SMP interactive flat panel only: The external power supply
needs to meet the Limited Power Source (LPS) requirements of CSA/UL/IEC/EN 60950-
1, when required.

This SMART product should be used only with European TN and TT power distribution
systems.

It is not suitable for older, IT-type power distribution systems found in some European
countries. "This system (IT-type) is widely used isolated from earth, in some
installations in France, with impedance to earth, at 230/400V, and in Norway, with
voltage limiter, neutral not distributed, at 230V line-to-line." (IEC 60950:1999)

Contact qualified personnel if you’re uncertain of the type of power system available
where you're installing your SMART product.

You must connect the USB cable that came with your SMART Board® interactive flat
panel to a computer that has a USB compliant interface and that bears the USB logo. In
addition, the USB source computer must be compliant with CSA/UL/EN 60950 and bear
the CE mark and CSA and/or UL Mark(s) for CSA/UL 60950.This is for operating safety
and to avoid damage to the SMART Board interactive flat panel.
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CHAPTER 1

About your interactive flat panel

Commercial-grade, touch-enabled flat panel

Your SMART Board 8055i interactive flat panel features SMART’s proprietary DViT® (Digital
Vision Touch) technology on an LCD screen which enables you to select, write and erase on the
interactive surface. It enables you to do everything that you can do at your computer—open and
close applications, conference with others, create new documents or edit existing ones, visit
websites, play and manipulate video clips and more—just by touching the interactive surface.
Two users can also draw on the interactive surface at the same time and you can use an array of
gestures within applications.

Elegant, sophisticated design
The professional design and crisp, eye-catching visuals of the SMART Board 8055i interactive
flat panel make it perfect for any high-end workspace.

Software

To use all the features of your interactive flat panel described in this guide, go to
smarttech.com/downloads and ensure that you have the latest version of SMART software and
SMART Product Drivers installed on your computer.

Presence detection

The interactive flat panel has two presence detection sensors on its frame that can detect people
up to 5m (16') away. When the sensors detect people in the room, the interactive flat panel turns
on. When the sensors no longer detect people in the room, the interactive flat panel turns off.

Dual sketch capabilities
Two people can each pick up a pen and draw on the interactive surface at the same time,
providing a higher degree of interactivity.

SMART Ink™

SMART Ink enables you to write and draw in digital ink over open applications, files, folders,
websites and any other open window on your computer. When you write outside the open
windows on your computer, a SMART Ink Note appears and you can write inside the note.

When you open an application that has its own ink tools, you can tum off SMART Ink and then
use the application's ink tools to write in the content.

For more information, see the SMART Ink user’s guide for Windows® operating systems
(smarttech.com/kb/170191) or SMART Ink user's guide for Mac OS X operating system software
(smarttech.com/kb/170192).



http://www.smarttech.com/downloads
http://www.smarttech.com/kb/170191
http://www.smarttech.com/kb/170192

CHAPTER 1

About your interactive flat panel

Touch and gestures

You can perform mouse functions with your finger and write and erase digital ink with a pen tray
pen or the eraser. The object awareness feature enables you to pick up a pen and then write,
select or erase without replacing the pen.

Durable surface
The SMART Board 8055i interactive flat panel features a hardened glass screen.

Front view

The front of your interactive flat panel includes the LCD screen, the cameras and reflective tape
channel, sensors for presence detection, the pen holders with the pens, the eraser holder with an
eraser and the colour select module.

Sensors for K
presence
detection L

Cameras
Cameras Front control

panel

Pen holders

[ e—)) :D\ [(————)

Colour select module— Eraser holder

LCD screen
The screenis 133cm W x 82cm H (52 3/8" x 32 5/16"), with a 140cm (55") diagonal, 16:9 format.

For information on cleaning your LCD screen, see Cleaning the screen on page 52.

Presence detection

The interactive flat panel has two presence detection sensors on its frame that can detect people
up to 5m (16') away.When the sensors detect people in the room, the interactive flat panel tums
on.When the sensors no longer detect people in the room, the interactive flat panel turns off.

For information on cleaning your sensors, see Cleaning the presence detection sensors on page
52.For more information on presence detection settings, see Proximity control settings on page
72.
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H NoTE

If ECO STANDBY is enabled, presence detection functionality is limited.For more information,
see Setup settings on page 72

Camera and reflective tape channel

The interactive flat panel screen is bordered by a channel that contains reflective tape. Each
corner has a camera that tracks finger and pen positions across the screen.For information on
cleaning your camera windows and reflective tape, see Cleaning the screen on page 52.

CAUTION

o Do not damage or remove the reflective tape.
o Keep the reflective tape dry.

IMPORTANT

o Do not attach items such as adhesive notes to the screen because they will interfere

with the cameras.
o Do not place anything in the channel because it will interfere with the cameras.

Pen and eraser holders
The bottom bezel contains magnetic holders for two pens and an eraser. Removing a pen or the
eraser from the holders activates it and enables you to either draw or erase digital ink.

CAUTION

When returning the pen or eraser to the magnetic holder, ensure that it is centred on the holder
to prevent the pen or eraser from falling and potentially being damaged.

Colour select module
The colour select module enables you to access the help function, open the on-screen keyboard,
select pen colour, activate the right-click and orientate the interactive flat panel.

.—I—.
®) e b\
/| |
On-screen Pen J:m'n ur
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Orientate the
interactive fatpanel
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About your interactive flat panel

Front control panel

The front control panel contains the volume
control, mute, input and power buttons, as
well as the status light and infrared remote
control sensor.

IMPORTANT

Do not cover or block this area or you
could have reduced use of the infrared
remote control.

In normal use

e The volume, mute and input buttons
are blue.

o The power button is green.
o The status light is green.

For information on diagnosing issues using
the front control panel lights, see
Diagnosing blank screen issues using the
front control panel lights on page 57.

Infrared remote control
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Power
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Infrared remote

control sensor

The infrared remote control enables you to turn on and turn off your interactive flat panel, change
the input source, adjust the volume, access the on-screen menu and more.For more information
on the infrared remote control, see Using the infrared remote control on page 26.
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Left side view il
The left side of your interactive flat panel has Menu control 'g
the menu control panel and the side terminal panel @%
panel. USB A port for a @®
USB drive
USB B port for a

guest laptop (USB 3)

&

b [ L+
(el 180D

HDMI video -~ d
input for a guest e & d
laptop (HDMI 2) —

Menu control panel

The menu control panel enables you to access the on-screen display menu to adjust display and
audio settings.For more information on the on-screen display menu, see Adjusting video settings
with the on-screen display menu on page 69.

USB port
The USB port takes a USB type A connector, such as a USB memory drive.For more information
on this port, see Using the USB port on page 42.

H NoTE

You can disable this USB port so that a computer cannot access it.For instructions, see
Disabling the USB port on the side terminal panel on page 19.

Side terminal panel
The side terminal panel has USB and HDMI ports for connecting a guest laptop.For more
information on the side terminal panel, see Connecting a guest laptop on page 43.

Back view
The back of the interactive flat panel includes the bottom terminal panel, the inside terminal panel
and the speaker wire connections.

IMPORTANT

Connect all required cables before you wall-mount your interactive flat panel. Some connectors
could be inaccessible after wall mounting.
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[rf 3 Speaker mounting holes

[ = . .
N n1i Inside terminal

. : F‘ ﬂ panel

‘ ° I_/;

- =
==

h : * Bottom terminal panel
(Speaker wire connections located here)

Bottom terminal panel

The bottom terminal panel contains the main power switch and several connections, including
both touch control connections and connections for auxiliary input and output devices, such as
DVD players, Blu-ray™ players and VCRs.

Audio In 1
Main power Ch/Pb Audio In 2
switch .
Cr/Pr Audio In 3

| /
) \o
AC power socket for

designated SMART AC In DisplayPort  py_p VGA OutC S—Vi(ieo In- N o SPeaker wire
products only omposite connections
VGA 2 video ut
CAUTION

The AC power socket is designated for a component of the SMART Board 8055ie-SMP
interactive flat panel with appliance.See Replacing the appliance on your SMART product
(FRU - Appliance - SB8) (smarttech.com/kb/170062).
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Inside terminal panel

The inside terminal panel is on the left side of
the interactive flat panel anq contains the - Room control
touch control USB connections and the room input

control input and output.

USEB 1 for ¢ [~ Room controf
computer 1 output

4

usezfr |0
computer 2 ‘\\ s

Speaker wire connections
The speaker wire connections are located in the
bottom terminal panel.

Speaker wire connections
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Installing your interactive flat
panel

Environmental reqUiremMents . 9
Wall-mounting your interactive flat panel ... ... 10
Important mounting considerations for trained installers ....................................... 11
Choosing a mounting location ... ... 11
Choosing a mounting height ... ... 12

You need a team of professional installers to install your SMART Board 8055i interactive flat
panel.

This chapter provides additional considerations and details for installing your interactive flat
panel.

IMPORTANT

Because the ports might not be accessible after wall-installation, consider connecting cables
for speakers, computers and peripheral devices whilst the interactive flat panel is still in its
packaging or is suspended from a lifting device.For more information, see Connecting
computers and peripheral devices on page 13.

Before installing your interactive flat panel, review the following environmental requirements.For
more detailed information, see SMART Board 8055i and 8055i-SMP interactive flat panel
specifications (smarttech.com/kb/170179) or SMART Board 8055ie-SMP interactive flat panel
with appliance specifications (smarttech.com/kb/170178).

Environmental requirement = Parameter

Power requirements 0.8Ato 1.8A at 100V to 240V AC, 50 Hz to 60 Hz

Power consumption at 25°C Typically up to 148 W (brightness at 80% and volume at 50),
(77°F) maximum 178 W (brightness and volume at maximum)
Operating temperature 5°C t0 35°C (41°F to 95°F)

Storage temperature -20°C to 60°C (-4°F to 140°F)



http://www.smarttech.com/kb/170179
http://www.smarttech.com/kb/170178

CHAPTER 2

Installing your interactive flat panel

Environmental requirement

Parameter

Humidity

5% to 80% relative humidity, non-condensing

Ventilation

Maintain a 10cm (4”) ventilation area around your interactive
flat panel to enable its cooling fans to operate. Do not store or
operate your interactive flat panel in dusty environments
because dust could interfere with the product’s ventilation and
cooling.

Water and fluid resistance

o Intended for indoor use only. Doesn’'t meet any salt-
spray or water ingress requirements.

o Don't pour or spray liquids directly onto the interactive
flat panel or any of its sub-components. These liquids
might get into areas where they could damage
sensitive electronic components.Refer to page 52 for
detailed instructions on cleaning your interactive flat
panel.

Use ateam of trained, professional installers to install your interactive flat panel.

N WARNING

o Improper installation can result in personal injury or product damage.

o Your interactive flat panel weighs 44.5kg (98 Ib). Refer to local building regulations to
ensure that your installation area can support this weight.

CAUTION

Do not allow the weight of the interactive flat panel to rest on the colour select module because
it is not designed to support product weight. Attach other components whilst the interactive flat
panel is either still in its packaging or suspended from a lifting device to prevent the weight of
the interactive flat panel from damaging the colour select module.

IMPORTANT

o Save all product packaging so that it is available if you need to transport your interactive
flat panel.If your original packaging is not available, you can purchase new product
packaging from your authorised SMART reseller (smarttech.com/where).

o Attach the speakers and connect the speaker wires to the interactive flat panel before
you wall-mount it.For more information, see Installing the speakers on page 14.

10
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Installing your interactive flat panel

Important mounting considerations for trained installers
Consider the following when mounting the interactive flat panel on a wall:

o Plan your workflow to include cabling because some cable connection points might not be
accessible after installation.

o Carry and lift the interactive flat panel by gripping the handles and sides.

s -~ T = A — = o —
[ [
° - 0 g ) o

l I

e To mount the interactive flat panel on a wall, you require a standard VESA 600 mm x 400
mm compatible wall mount bracket (not included). The wall mount bracket must have
minimum depth of 14 mm to ensure sufficient space for the speakers.

Use M8 screws to fasten the wall bracket. The screws must be 14—15 mm long plus the
thickness of the bracket and the washer.

The recommended fasten force is 11.25-13.75 N-m (99.57-121.70 in-Ib. ).

Refer to the instructions included with the mounting equipment for more detailed
information.

Choosing a mounting location
Consider the following when you select a location for the interactive flat panel:

e The wall must be strong enough to support the interactive flat panel and the mounting
equipment. The interactive flat panel weighs 44.5kg (98Ib).

o Donotinstall the interactive flat panel in a location where a door or gate could hit it.

o Do not install the interactive flat panel in an area where it will be subjected to strong
vibrations or dust.

o Do notinstall the interactive flat panel near where the main power supply enters the
building.

o Ensure adequate ventilation or provide air conditioning around the interactive flat panel so
that heat can flow away from the unit and the mounting equipment.

11
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o If you mount the interactive flat panel in a recessed area, leave at least 10cm (4") of space
between the interactive flat panel and the recess walls to enable ventilation and cooling.

Choosing a mounting height
Consider the general height of your user community when your choose the mounting height for

the interactive flat panel.
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Connecting computers and
peripheral devices

Installing the SpeaKers .. . 14
Connecting aroom control system ... 15
Connecting computers to your interactive flatpanel ... .. ... ... ... 16
Interactive flat panel touch control and video input connections _..._.......................... 16
Connecting to power and computer 1 ... 17
Computer 1 connection diagram ... 17
Installing computer 2 connection ... il 18
Computer 2 connection diagram ... ... .. L 18
Disabling the USB port on the side terminal panel ... .. ... ... ... 19
Connecting peripheral devices to your interactive flat panel ... ... .. . ... 20
Bottom terminal panel .. ... . . .. 20

This chapter includes information on connecting your interactive flat panel to computers and other
peripheral devices.

IMPORTANT

Because the cable connection points might not be accessible after wall-mounting, consider
connecting these devices before wall-mounting your interactive flat panel.

13
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Your interactive flat panel comes with two 15 W speakers.
Speaker mounting holes

® s
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8
°
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il ' .nll,, N
Speaker wire
connections
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To install the speakers
Attach the speakers to the speaker mounting holes on the side of the interactive flat panel

1.
with the screws included.
Connect the speaker wires to the speaker wire connections on the bottom terminal panel.

Run the speaker wire for the left speaker (when viewed from the back of the interactive flat
panel) below the bottom terminal panel and secure it with the small clamps included.

14
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Connecting computers and peripheral devices

You can control your interactive flat panel from a room control system.

To connect your interactive flat panel to a room control system

Connect an RS-232 cable from the room control input on the inside terminal panel of the
interactive flat panel to the serial output on your computer or room control system.

IMPORTANT

Do not use a null modem cable. Use only a standard RS-232 cable.
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Inside terminal panel

For more information about setting up and programming a room control system, see

Remotely managing your SMART Board 8055i interactive flat panel
(smarttech.com/kb/170189).
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Connecting computers and peripheral devices

You can connect up to three computers simultaneously to your interactive flat panel:
e Computer 1 (an installed room computer) connected to USB 1 and VGA 1
e Computer 2 (a guest computer) connected to USB 2 and VGA 2

¢ A guest laptop connected to USB 3 and HDMI 2 connector

H NoTE

This document describes the default USB and video connections.To customise the USB and
video mapping, see Configuring the video and touch input for your SMART Board 8055i
interactive flat panel (smarttech.com/kb/170190).

To USB 2
‘ and VGA 2
\
To USB 3
and HDMI 2 ToUSB 1
! and VGA 1
Guest laptop
LY Computer 1

Computer 2

Interactive flat panel touch control and video input connections
The following table shows which touch control USB connection corresponds with which video
input for each computer connection.

Touch control Video input Installation steps
Computer 1 USB 1 (inside terminal VGA 1 page 17

panel)
Computer 2 USB 2 (inside terminal VGA 2 page 18

panel)
Guest laptop USB 3 (side terminal HDMI 2 page 43

panel)

16
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Connecting computers and peripheral devices

Computer 1 (the room computer) is the default computer for your interactive flat panel. Connect
this computer to your interactive flat panel with a VGA cable and a USB cable.

Computer 1 connection diagram

\BO//
ol uss 1
Main power \q/
switch —
A
m

To connect your interactive flat panel to power and computer 1

1. Connect the VGA cable included from computer 1 to the VGA 1 port on the bottom terminal
panel.

2. Connect the USB cable included from the USB 1 port on the inside terminal panel of the
interactive flat panel to a USB port on the computer.

3. Connect the power cable included from the AC IN connector on the bottom terminal panel
to a power socket.

4. Connect the power cable from your computer to a power socket.
5. Turn on your computer.

6. Turn on the main power switch on the bottom terminal panel, and then press the Power
button U on the front control panel.

7. Press the VGA 1 button on the remote control.

OR

Press the Input button ] on the front control panel until the input source is VGA 1.

17
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Connecting computers and peripheral devices

You can install cabling that enables you to connect a second computer to your interactive flat
panel from another location in the room, such as on a conference table.By installing this
connection, you make use of connection points that might not be accessible when your
interactive flat panel is wall-mounted.

You need a USB cable and a VGA cable to install the computer 2 connection. You may install
these cables and run them through floors or walls to a nearby table.

Alternatively, your users can connect a laptop to the side terminal panel using the more
accessible USB port and HDMI input.For more information, see Connecting a guest laptop on
page 43.For a diagram of the various computer options, see Connecting computers to your
interactive flat panel on page 16.

N WARNING

Ensure that any cables extending across the floor to your SMART product are properly bundled
and marked to avoid a trip hazard.

H NoTE

You do not require a laptop to install this cabling.

Computer 2 connection diagram
4"\\

USB 2

18
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To setup the computer 2 connection location

1. Connect a USB cable to the USB 2 port on the inside terminal panel and then run the cable
to the laptop connection location, such as beside the interactive flat panel oron a
conference table.

2. Connect a VGA video cable to the VGA 2 interactive flat panel port on the bottom terminal
panel and then run the cable to the computer 2 connection location as above.

3. Bundle and cover the cables as appropriate to avoid a trip hazard.

To connect and use a computer using this installed connection, see Connecting computer 2 on
page 46.

You can connect a USB drive or other USB device to the USB port on the side terminal panel of
your interactive flat panel and then access the device from computer 1.For more information, see
Using the USB port on page 42.

You can also disable this USB port so that it doesn’t access any of the computers connected to
your interactive flat panel.

CAUTION

Disconnect the power supply for your interactive flat panel before you disable the USB port.

To disable the USB port

1. Locate the rectangular cut-out on the back of your interactive flat panel.

:_ o

5] = C &
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2. Remove the screw securing the cut-out with a Phillips screwdriver. Retain the screw and
cut-out.

3. Locate the black jumper connector on the circuit board inside the panel.

4. Pull the black jumper connector off of the circuit board with the pliers.

CAUTION

To prevent damage to the circuit board, do not touch the circuit board with the pliers.

IMPORTANT

You can install the jumper connector again to enable the USB port.

Connect peripheral devices to the bottom terminal panel.

CAUTION

The AC power socket is designated for a component of the SMART Board 8055ie-SMP
interactive flat panel with appliance.See Replacing the appliance on your SMART product
(FRU - Appliance - SB8) (smarttech.com/kb/170062).

Bottom terminal panel

Audio In 1

Main power Chb/Pb Audio In 2
switch
o o

CriPr / Audio In 3
i1
T ©® R
/ 00
AC power socket for / \ \ \ \

©—
@\

designated SMART ACin  DisplayPort pyj.p | VGAOut ) S‘V"‘zeo In- N o SPeaker wire
roducts onl omposite connections
p y VGA 2 video ut

To connect a peripheral device
1. Turn off the interactive flat panel and the peripheral device.

2. Connect the peripheral device’s input cables to the appropriate connectors on the bottom
terminal panel.

H NoTE
You can secure these cables with the large clamps included.

3. Turn on the interactive flat panel and then turn on the peripheral device.
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Installing SMART Meeting Pro software . ... ... e 21
Installing SMART Notebook software ... ... . 22

IMPORTANT

If you already have SMART Meeting Pro software or SMART Notebook™ collaborative
learning software installed on your computer, ensure that your computer has

SMART Product Drivers 11 or later installed.For more information, see Updating SMART
Product Drivers on page 49.

You need to install SMART software on the computer that’s connected to your interactive flat
panel in order to use the interactive flat panel. You can install either SMART Meeting Pro
software or SMART Notebook software.

SMART Board 8055i-SMP interactive flat panels also include a SMART GoWire auto-launch
cable that provides the features of SMART Meeting Pro software without installing the software
on your computer.For more information about using the SMART GoWire auto-launch cable, see
Using a SMART GoWire cable on page 44.

H NoTE

For laptops that are only occasionally used for your interactive flat panel, you can use a
SMART GoWire cable instead of installing SMART Meeting Pro software.

Once you install SMART Notebook software or SMART Meeting Pro software on the computer
that's connected to your interactive flat panel, you have touch control of that computer's desktop.
You can open files, move icons and write or erase digital ink using the pens and eraser included.

You can download and install SMART Meeting Pro software from the SMART website.

IMPORTANT

Register your product at smarttech.com/registration so that you can obtain a software product
key which is required for activation.
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To downloadSMART Meeting Pro software

1.

2
3.
4

Go to smarttech.com/downloads.

. Scroll to the SMART Meeting Pro software section.

Click Choose a version and then select the version that you require.

Follow the on-screen instructions to save the executable file to your desktop.

To install SMART Meeting Pro software

1.
2.

Double-click the executable file.

Follow the on-screen instructions.

Install SMART Notebook software from the included DVD (SMART Board 8055i interactive flat
panels only) or from smarttech.com/downloads.

IMPORTANT

Connect to the Internet before you install SMART software so that you can obtain a software
product key (smarttech.com/registration) and download software updates.

To install SMART Notebook software

1.

22

Place the software DVD included in your computer's DVD tray.
The installation wizard appears.

Follow the on-screen instructions. You'll be prompted to enter your product key.You can
register your interactive flat panel at smarttech.com/registration to receive your product

key.

Click the SMART Board icon | “ ] in the notification area (Windows operating systems) or
the Dock (Mac OS X operating system software) and then select Check for Updates and
Activation.

The SMART Product Update window appears.

Follow the on-screen instructions to update your SMART Notebook software to the latest
version.
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Using the USB port

This chapter includes information on how to use your interactive flat panel, turn on and turn off
your interactive flat panel, control your computer by touching the screen, use the remote control
and more.
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To turn your interactive flat panel on

T

24
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If presence detection is enabled, the interactive flat panel turns on and the welcome screen
appears automatically when people enter the room. Dismiss the welcome screen by touching

the interactive flat panel screen.For more information, see Understanding presence detection
on the next page

1. Turn your computer on.

2. Press the Power button Q) on the front control panel.

You can also press the POWER ON button on the remote control.

Your computer’s logon screen or desktop appears on your interactive flat panel.

IMPORTANT

If the power button light on the front control panel is off, either the interactive flat panel is
not plugged in or the main power switch on the bottom terminal panel is turned off.To find
the main power switch, see Back view on page 6.

o turn your interactive flat panel off
1. Turn your computer off.

2. Press the Power button d) on the front control panel.

You can also press the STANDBY button on the remote control.

H NoTE

If presence detection is enabled, the interactive flat panel turns off automatically when
the sensors no longer detect people in the room.For more information on presence
detection settings, see Proximity control settings on page 72
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If ECO STANDBY is enabled, presence detection functionality is limited.For more information,
see Setup settings on page 72

e

J

Sensors for

presence
B detection

[@]1]

T @ C o c=

The interactive flat panel has two presence detection sensors on its frame that can detect people
up to 5m (16') away.When the sensors detect people in the room, the interactive flat panel turns
on.When the sensors no longer detect people in the room, the interactive flat panel tums off.

For information on cleaning your sensors, see Cleaning the presence detection sensors on page
52.For more information on presence detection settings, see Proximity control settings on page
72.
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The infrared remote control enables you to turn on and turn off your interactive flat panel, change
the input source, change the volume and more. You can also use the remote control to open the
on-screen menu and then change the interactive flat panel’s settings.

If the remote control doesn’t respond, see Resolving remote control issues on page 65.

CAUTION

o Do not subject the remote control to strong shock.

o Keep the remote control away from liquids. If it gets wet, wipe it dry immediately.
o Do not expose the remote control to heat or steam.

o Do not open any part of the remote control other than the battery compartment and
picture-in-picture compartment.

IMPORTANT

The remote control system does not function when strong light strikes the remote control
sensor or when there is an object between the remote control and its sensor.

Installing batteries in the remote control
Your remote control requires two 1.5V AA batteries.

N WARNING

To reduce the risk associated with leaking batteries:
o use only AA type batteries
o do not mix used and new batteries

o orientate the battery’s plus (+) and minus (-) terminals according to the markings found
on the remote control

o do not leave the batteries in the remote control for an extended period

o do not heat, disassemble, short or recharge the batteries, or expose them to fire or high
temperature

o avoid eye and skin contact if batteries have leaked

o dispose of dead batteries and product components in accordance with applicable
regulations
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To install batteries in the remote control
1. Press the tab on the underside of the remote control and then open the cover.
2. Remove the batteries if they are present.

3. Insert two new 1.5V AA batteries in the remote control.Ensure that the + and - markings on
the batteries align with the markings in the remote control.

4. Replace the cover.

Infrared remote control sensor

The infrared remote control sensor is
located on the front control panel. It
enables you to control your interactive
flat panel from an angle of 30° and within o
adistance of 7m (23') using the included
remote control.

IMPORTANT

The remote control might not function
when the infrared remote control
sensor is blocked or when it is in l

direct sunlight or strong lighting. C O

0

Ny
30° 30°

27



CHAPTER 5

Using your interactive flat panel

The remote control enables you to access on-screen menus and

Infrared remote control buttons e
2__A5PECT STILL Pl’fégbéE MTS 1 23
gmelL L 1 b

change display and input settings.

Use the remote control’'s POWER ON button to turn your interactive
flat panel on and the STANDBY button to turn it off.

Use the remote control’s input buttons to change input sources when
switching between the connected computers.

REMOTE CONTROLLER RU-SMTSS

Number Function

Description

1 POWER ON Turns your interactive flat panel on
STANDBY Turns your interactive flat panel off
2 ASPECT Selects picture aspect
STILL Turns the still picture mode on or off
4 Number pad Press buttons on the number pad to set and change
passwords, change channels or to customise or change
settings
5 DISPLAY Turns the on-screen display menu on and off
6 SET Makes selection
87 Left/Right Increases or decreases the adjustment level within the
on-screen display menu
8 AUTO SET UP Enters auto setup menu
9 VOL +/- Increases or decreases audio output level
10 AUDIO INPUT Selects audio input source
11 Input buttons Selects input signal for the interactive flat panel
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Number Function Description

12 SLEEP Sets a timer to turn off the interactive flat panel

13 PIP buttons Not in use

14 OPTION Not inuse

15 INPUT Toggles between the different input signals for the interactive
flat panel

16 SOUND Selects artificial surround sound

17 MUTE Mutes audio inputs for your interactive flat panel

18 EXIT Returns to previous menu

19 Up/Down Moves the highlighted area up or down to select items within
the on.screen display menu

20 MENU Turns the menu mode on and off

21 * Not in use

22 PICTURE MODE Selects picture mode

23 MTS Not in use
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Using your SMART Board interactive flat panel, you can write, draw and erase digital ink,
manipulate objects and browse content on the screen.

About SMART Ink
SMART Ink enables you to write and draw in digital ink over open applications, files, folders,
websites and any other open window on your computer.

You can write over an Internet browser window, highlight content on your screen and write over a
video without pausing the video and without interfering with your ability to interact with the video.
When you move, resize or minimise a window, the ink stays with the window.

You can convert your digital ink notes to text. You can also move, erase and capture your notes
as an image and save it to your SMART software.

When you open an application that has its own ink tools, you can turn off SMART Ink, and then
use the application's ink tools to write.

For more information see SMART Ink for Windows (smarttech.com/Supportink1Windows) or
SMART Ink for Mac (smarttech.com/Supportink 1Mac) on the SMART Support website.

SMART Ink Notes

SMART Ink Notes enable you to write in digital ink anywhere on your desktop. When you write
outside of the open windows on your computer, a SMART Ink Note appears and you can write
inside the note.

SMART Ink Document Viewer
If you're using a Windows operating system, the SMART Ink Document Viewer enables you to
view your PDF files and to write in digital ink over your files.

SMART Ink Toolbar

If your computer is connected to a SMART interactive product, SMART Ink starts automatically
when you start your computer and the SMART Ink toolbar appears in the title bar of each open
window on your computer.

Use the toolbar to select ink properties for that window and to perform common tasks such as
capturing your notes.
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About your SMART software
SMART Ink and SMART Product Drivers are included with SMART Notebook collaborative
learning software and SMART Meeting Pro software.

SMART Product Drivers
SMART Product Drivers enables your computer to detect input from your interactive flat panel.

SMART Ink works with SMART Product Drivers to enable you to write on your screen in digital
ink using your interactive flat panel’s pen or your finger.

H NoTE

In most cases, SMART Product Drivers installs automatically when you install your SMART
software.To ensure you have the most recent version of SMART Product Drivers installed, see
Updating SMART Product Drivers on page 49.

SMART Notebook software

You can write in SMART Notebook software using your SMART interactive product’s pen or your
finger. The ink becomes part of your .notebook file.For more information, see the

SMART Notebook software support page for Windows
(smarttech.com/SupportNotebook11Windows) or SMART Notebook software support page for
Mac OS X operating system software (smarttech.com/SupportNotebook11Mac).

SMART Meeting Pro software

You can write in SMART Meeting Pro software’s Whiteboard mode using your SMART
interactive product’s pen or your finger. The ink becomes part of your .notebook file.For more
information, see the SMART Meeting Pro support page
(smarttech.com/SupportMeetingPro3Windows).

Writing or drawing in digital ink
Using the pen supplied with your interactive flat panel, you can write or draw digital ink over
SMART software and other programs.

To write or draw digital ink
1. Pick up the pen.

2. Write or draw on the screen.

B2 Tip

Don’t rest your elbow or the palm of your hand on the screen whilst you're writing.

Entering text on the interactive flat panel
You can enter text in text boxes on the interactive flat panel using the on-screen keyboard or a
keyboard attached to your computer.
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To enter text

1. Select the area where you want to enter text using your finger or a mouse connected to the
compulter.

2. Type on a connected keyboard or on-screen keyboard.

B2 Tip

Press the keyboard button on the interactive flat panel to open the on-screen keyboard.

Changing pen settings

You can change your pen settings, including line size and fill effects.

To change pen settings

1. Press the SMART Board icon | “]in the notification area (Windows operating systems) or
the Dock (Mac OS X operating system software).

OR
Press the SMART Meeting Pro icon EH in the notification area.
2. Press SMART Settings.

3. Select Pen and Button Settings in the drop-down list.

4. Press Black Pen Settings to customise the black pen.

Press Blue Pen Settings to customise the blue pen.

//qu

Press Red Pen Settings to customise the red pen.

Press Green Pen Settings to customise the green pen.

The Properties dialogue box appears.

Press Line Style.

Adjust the colour, thickness, line end and line style.
Press Fill Effects.

Adjust the transparency.

© ©® N o o

Press Save Tool Settings to save your settings.
10. Optionally, repeat steps 4 to 9 to customise other pens.

11. Press OK to close SMART Settings.

Using Locked Ink mode
Locked Ink mode enables you to write or draw digital ink using large objects, including eraser-
sized objects.

32



CHAPTER 5

Using your interactive flat panel

To use Locked Ink mode

Press and hold a colour button on the colour select module until the light flashes.

To end Locked Ink mode

Press any colour button that isn't flashing on your colour select module.
Erasing digital ink

To erase digital ink

Pick up the eraser and then press the eraser on the screen and move it over the digital ink
that you want to erase.

OR

Using your flattened fist, press the screen and move your hand over the digital ink that you
want to erase.

-
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Changing eraser settings
You can change the eraser size for either a larger or smaller eraser area.

To change eraser settings

1. Press the SMART Board icon [ “]in the notification area (Windows operating systems) or
the Dock (Mac OS operating system software) and then select SMART Settings.

OR

Press the SMART Meeting Pro icon FH in the notification area and then select
SMART Settings.

2. Press SMART Hardware Settings.

w

Select Pen and Button Settings in the drop-down list.

Press Eraser Settings i .

Select an eraser size.

Press OK to save your settings.

N o o A

Press OK to close SMART Settings.

Manipulating objects
Objects include icons, buttons, links and other components of programs that appear on your
screen. You can manipulate these objects on your interactive flat panel as described below.

To select or clear the selection of an object

Quickly press and release the object.

J———

"-i.

H NoTES
o This gesture performs a standard mouse click.

o This gesture starts programmes if your operating system is set to start
applications on a single click.
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To double-click an object

Quickly press and release the object twice in the same spot.

H nNoTE

This gesture starts programs if your operating system is set to start applications on a
double-click.

To right-click or Control-click an object

Press and hold the object.

J—

/

OR
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Using two fingers on the same hand, press and hold the object with your left finger and then
press the screen once with your right finger.

[

1 2

=

OR

Press the Right-Click button on the pen tray and then press the object.

To move an object
1. Press and hold the object.
2. Keeping your finger on the screen, slowly move the object.

3. When you reach the position that you want to move the object to, release your finger.
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To resize an object
1. Using one finger on each hand, press the screen at opposite ends of the object.

2. Drag your fingers in opposite directions to enlarge the object.

OR

Drag your fingers toward each other to reduce the object.

[ ——

To rotate an object

1. Using one finger on each hand, press the screen at opposite ends of the object.

2. Rotate your fingers in the direction that you want to rotate the object.
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3. When you reach the angle that you want to rotate the object to, release your fingers.

Browsing
In addition to manipulating objects, you can browse content on your screen.

[ To display the next page

Press the screen and then quickly press again directly to the right of that point.

OR

Quickly flick your finger right across the screen.
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To display the previous page

Press the screen and then quickly press again directly to the left of that point.

OR

Quickly flick your finger left across the screen.
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To zoom in or out
1. Using one finger on each hand, press the screen at opposite ends of the object.

2. Drag your fingers in opposite directions to zoom in.

OR

Drag your fingers towards each other to zoom out.

—

To pan horizontally or vertically

1. Using two fingers on the same hand, press and hold the screen.

2. Keeping your fingers on the screen, move up, down, left or right.
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/y

. When you reach the area that you want to view, release your fingers.

Your interactive flat panel includes two speakers that play audio files or the audio portion of a
video file.

When you play an audio file or a video file on a computer connected to your interactive flat panel,
the file is streamed through the USB connection between your computer and your interactive flat
panel, not through the video connection.

IMPORTANT

If your computer uses Mac OS X operating system software, you must set the audio output to
USB.

To switch your Mac computer to USB audio output
1. Press the Apple menu @ and then select System Preferences.
2. Press Sound under the Hardware section.
3. Press the Output tab.
4. Select SBID 8055i/USB.
5

Close System Preferences.
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You can connect a USB drive or device to the USB A port on the side terminal panel on your
interactive flat panel, and then access it from computer 1 connected to VGA 1 and USB 1.

H NoTE

To disable the USB A port on the side terminal panel, see Disabling the USB port on the side
terminal panel on page 19.

Menu control

panel \\

USB A port for a

USB drive N

USB B port for a
guest laptop (USB 3)

HDM! video
input for a guest d
laptop (HDMI 2)

To use the USB port

1. Press the VGA 1 button on the remote control.

Press the Input button ] on the front control panel until the input source is VGA 1.

2. Connect a USB device to the USB port.

3. Use computer 1 to access the content on your USB device.
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Connecting a guest laptoD ... oo 43
Usinga SMART GoWire cable ...l 44
Connecting ComMpPULer 2 . 46

You can connect a guest laptop to the side terminal panel of the interactive flat panel. When a
guest laptop is connected, the laptop’s desktop is displayed on the interactive flat panel and
touch interactivity is enabled.For a diagram of the various computer options, see Connecting
computers to your interactive flat panel on page 16.

IMPORTANT

The guest laptop must have SMART Product Drivers installed. If it does not, you will need to
connect the laptop to the interactive flat panel using a SMART GoWire cable.|f you purchased
an SBID8055i-SMP or SBID8055ie-SMP model, you can use the supplied SMART GoWire
cable to connect your guest laptop to the interactive flat panel.For more information, see Using
a SMART GoWire cable on the next page.
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To connect a guest laptop

1. Connect an HDMI cable from the guest laptop’s HDMI input to your interactive flat panel’s
side terminal panel.

2. Connect a USB cable from the laptop's USB port to your interactive flat panel’s side
terminal panel.

IMPORTANT
The USB A port is for USB devices only. Do not connect the guest laptop to this port.
3. Turnon the laptop.
4. Press the HDMI 2 input button on the remote control.
OR

Press the Input button =] on the front control panel until the input source is HDMI 2.

To return to using computer 1
1. Press the VGA 1 button on the remote control.

OR

Press the Input button =] on the front control panel until the input source is VGA.
Press the Input button ] on the front control panel until the input source is VGA 1.

2. Disconnect the guest laptop from the interactive flat panel if required.

Any computer connected to your interactive flat panel requires SMART software. Typically, you
install this software on your room computer so that it's always ready to use.

However, if you want to connect a laptop that doesn’'t have SMART software installed, you can
connect a SMART GoWire cable from the laptop to the USB cable for your interactive flat panel.
The SMART GoWire cable enables you to have touch control of your laptop and use

SMART Meeting Pro software without installing the software on your laptop.

A SMART GoWire cable is included with SMART Board 8055i-SMP and 8055ie-SMP interactive
flat panels.

IMPORTANT

Your interactive flat panel supports the SMART GoWire cable with SMART Meeting Pro
software only. It does not support the SMART GoWire cable with SMART Notebook software.
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To use a SMART GoWire cable

1.
2.

Connect a video cable from your interactive flat panel to your laptop.
Connect the USB cable from the USB port on your interactive flat panel to your laptop.

Change the video input to your laptop's video connection using the remote control or the
front control panel.

Disconnect the USB cable from your laptop and then connect it to the SMART GoWire
cable’s USB A port.

IMPORTANT

If the SMART GoWire cable is not connected to your interactive flat panel through a USB
cable, you have access to SMART Meeting Pro software on your laptop for five minutes,
and then the software closes.

Connect the SMART GoWire cable’s USB connector to your laptop.
The AutoPlay dialogue box appears.
Select Start SMART Meeting Pro.

SMART Meeting Pro software starts. You have touch control of your laptop on your
interactive flat panel and can use SMART Meeting Pro software while your laptop is
connected to your interactive flat panel.

To disconnect a SMART GoWire cable

45

1.

2.
3.

If required, save your SMART Meeting Pro software file to your laptop. You can save the
file as a .ppt, .pdf or .notebook file.

IMPORTANT

You can open a .notebook file on a computer that has SMART Meeting Pro software or
SMART Notebook software installed or that is connected to a SMART product through a
SMART GoWire cable only.

Press the SMART Meeting Pro icon ¥ in the notification area and then select Exit.

Disconnect the SMART GoWire cable from your laptop and the USB cable.
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You can connect a second laptop to the installed USB cable and video cable that is connected to
the back terminal panel of your interactive flat panel.If those cables aren't installed, connect the
laptop to the side terminal panel (see Connecting a guest laptop on page 43).For a diagram of the
various computer options, see Connecting computers to your interactive flat panel on page 16.

IMPORTANT

The laptop must have SMART Product Drivers installed. If it doesn’t, you need to connect the
laptop to the interactive flat panel using a SMART GoWire cable.If you purchased an
SBID8055i-SMP or SBID8055ie-SMP model, you can use the supplied SMART GoWire cable
to connect your laptop to the interactive flat panel.For more information, see Using a

SMART GoW’ire cable on page 44.

To connect computer 2

1.

2
3
4.
5

Place the laptop beside the ends of the cables at the computer 2 connection.
Connect the installed USB cable to a USB port on the laptop.

Connect the VGA cable connector to the laptop.

Turn on the computer.

Press the VGA 2 button on the remote control.

OR

Press the Input button B] on the front control panel until the input source is VGA 2.

To return to using computer 1

46

Press the VGA 1 button on the remote control.

OR

Press the Input button B on the front control panel until the input source is VGA 1.
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Orientating your interactive flat panel . ... . . L 51

Replacing a PeN NIb 51

Cleaning the SCreeN .. .. .. 52

Cleaning the presence detection sensors ... ... 52

Cleaning the camera windows and reflectivetape ... .. .. ... 53

Maintaining ventilation ... .. .. i 53

Preventing CoNdensation ... ... 54

Checking the interactive flat panel installation ... ... 54

Removing yourinteractive flat panel . ... ... . ... 54

Transporting your interactive flat panel .. ... 56

If you properly maintain your interactive flat panel, it will provide years of use.

To use touch control and digital ink on your interactive flat panel, you require SMART software on
your computer and up-to-date firmware on your interactive flat panel.

Updating SMART software

Once you have SMART software installed on your computer, you can check for software updates
with SMART Product Update by selecting Help > Check for Updates in the software or by
browsing to smarttech.com/downloads.
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To check for software updates
1. Start your SMART software program.
2. Click Help > Check for Updates.

IMPORTANT
If you do not see the Check for Updates option, contact your network administrator.
3. Click the Update button beside the software that you want to update.
SMART software updates.

IMPORTANT

When you update SMART software on your computer, a firmware update for your interactive
flat panel could download to your computer. The next time you connect your computer to your
interactive flat panel you are informed that there is a firmware update for the processor in the
interactive flat panel.For more information, see Updating your interactive flat panel firmware
below.

Updating your interactive flat panel firmware

CAUTION
Only a system administrator should update interactive flat panel firmware.
Your interactive flat panel uses firmware on its processor. Once you have updated SMART
software, a new firmware executable file will be saved on your computer. When you connect a

computer with this file to your interactive flat panel, your interactive flat panel detects this
executable file and then prompts you to run the file to update the firmware.

CAUTION

« Only one interactive flat panel can be connected to the computer during the firmware
update process.

o Do not disconnect your interactive flat panel from your computer during the firmware
update process.

o Do not touch your interactive flat panel’s screen or input button during the firmware
update process.

o Do not turn off your computer or your interactive flat panel during the firmware update
process.
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To update your interactive flat panel firmware

1.
2.

Ensure your interactive flat panel is connected to your computer.
Launch the firmware updater at the following location:

Windows computers: C:\Program Files\SMART Technologies\SMART Product
Drivers\SMARTFirmwareUpdater.exe.

Mac computers: HD\Applications\SMART Product
Drivers\SMARTFirmwareUpdater.app.

Follow the on-screen instructions using your computer's mouse and keyboard. Don’t touch
the interactive flat panel screen.

Select the tickbox for the SMART interactive product that you want to update and then
click Next.

A progress bar appears.

H NoTE
SC14 refers to the SMART Board 8000 series interactive flat panel’s serial controller.

When the installation is complete, calibrate your interactive flat panel.See Calibrating your
interactive flat panel on the next page

Updating SMART Product Drivers
To use touch control and digital ink on your interactive flat panel, you require
SMART Product Drivers 11 or later on your computer.

To update SMART Product Drivers

1.

3.
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Click the SMART Board icon | “] in the notification area (Windows operating systems) or
the Dock (Mac OS X operating system software) and then select Check for Updates and
Activation.

OR

Click the SMART Meeting Pro icon [ in the notification area and then select Check for
Updates and Activation.

The SMART Product Update window appears.
If your version of SMART Product Drivers is up to date, click OK.
If your version of SMART Product Drivers needs to be updated, click Update.

Follow the on-screen instructions to update SMART Product Drivers to the latest version.
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Digital cameras in the corners of the interactive flat panel track the position of the pens, eraser
and your finger on the interactive surface, and then send the information to the SMART software,
which interprets this information as mouse clicks, digital ink or ink removal in the appropriate
location. Calibration determines the position and angles of the cameras to accurately identify the

location of touches on your interactive flat panel.

IMPORTANT

If an error message appears while you are calibrating your interactive flat panel, contact
SMART Support (smarttech.com/contactsupport).

To calibrate yourinteractive flat panel
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1.

o o &~ »

Press the SMART Board icon |.* | in the notification area (Windows operating systems) or
the Dock (Mac OS X operating system software).

OR

Press the SMART Meeting Pro icon [ in the notification area.

Select SMART Settings.

SMART Settingsappears.

Press SMART Hardware Settings.

If you have more than one SMART product connected, select the interactive flat panel.
Select Advanced Settings from the drop-down list.

Press Calibrate.

The calibration screen appears. This can take a few moments.

Press the red target with the tip of an interactive flat panel pen. Hold the tip at the centre of
the target until the target turns green and then lift the pen.

The target moves to the next location.

H NoTE

You can calibrate a target again by pressing the LEFT ARROW key on your keyboard, or
the Keyboard button or Right-click button on the colour select module.

Continue pressing targets until the calibration is complete.

A message appears stating that the calibration was successful and then the orientation
screen appears.

Orientate your interactive flat panel.
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When the location of your touch is misinterpreted (a pointer appears a distance from the actual
contact), orientate your interactive flat panel.

To orientate the interactive flat panel
1. Press the orientation button -+ on the colour select module.
The orientation window opens.

2. Use aninteractive flat panel pen to press the red targets as they appear. Hold the tip of the
pen at the centre of each target and then lift the pen. When you lift the pen, the target
moves to the next orientation point.

IMPORTANT
Hold the pen perpendicular to the screen.
3. Continue until you've pressed all the targets.
The orientation window closes.

If this doesn’t correct inaccurate touch control, calibrate your interactive flat panel.For more
information, see Calibrating your interactive flat panel on the previous page.

To prevent damage to your interactive flat panel’s anti-glare coating, replace your pen nib if it
becomes worn.Four replacement pen nibs are included with your pens and you can purchase
additional replacements from your authorised SMART reseller (smarttech.com/where).

To replace a pen nib

1. Grasp the worn nib on your pen with a pair of pliers and then pull and twist the nib loose.

2. Press the replacement nib into the pen.
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Follow these instructions to clean the interactive flat panel screen without damaging its anti-glare
coating or other product components.

CAUTION

o Do not use permanent or dry-wipe markers on the screen. If dry-wipe markers are used
on the screen, remove the ink as soon as possible with a lint-free, non-abrasive cloth.

o Do not rub the screen with a dense or rough material.
o Do not apply pressure to the screen.

o Do not use cleaning solution or glass cleaner on the interactive flat panel screen, as they
can deteriorate or discolour the screen.

o Avoid touching the silver reflective tape between the screen and the bezel and ensure
that it stays dry. Damage to this strip affects touch interactivity.

To clean the interactive flat panel screen

1. Shut down your computer and then disconnect the power sources for your computer and
your interactive flat panel.

2. Wipe the screen with a lint-free, non-abrasive cloth.

The interactive flat panel has two presence detection sensors on its frame.The sensors should be
inspected annually for dust and should be cleaned if any obvious dust buildup has occurred.

CAUTION

Do not use compressed air, water, chemical agents or cleaning agents to clean the sensors.

To clean the sensors

Gently wipe the sensors using a clean lint-free cloth.

52



CHAPTER 7

Maintaining your interactive flat panel

The DVIT technology in your interactive flat panel uses four cameras in the corners of the frame
and the reflective material between the screen and the bezels. Excessive dust buildup on the
camera windows or reflective tape can impair touch performance.

These areas should be inspected annually for dust and should be cleaned if any obvious dust
build-up has occurred.

CAUTION
e Do not use compressed air to clean the camera windows or borders.

o Do not use water, chemicals or cleaning agents.

To clean the camera windows and reflective tape

1. With a clean lint-free cloth, gently wipe the camera windows in the top corners and the
reflective tape along the top of your interactive flat panel screen using the cloth.

2. Gently wipe the reflective tape along the sides of your interactive flat panel screen.

3. Gently wipe the camera windows in the bottom corners and the reflective strip across the
bottom of your interactive flat panel screen.

Your interactive flat panel requires ventilation to enable the cooling fans to function. Dust buildup
in the ventilation holes compromises cooling and leads to product failure.

CAUTION
Avoid setting up or using your interactive flat panel in an area with excessive levels of dust,
humidity or smoke.
¢ Clean accessible ventilation holes monthly with a dry cloth.

o Use avacuum cleaner with a narrow hose end fitting to clear the back ventilation holes
annually. You might have to remove the interactive flat panel from your wall.For more
information on removing your interactive flat panel see Removing your interactive flat panel
on the next page.
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Your interactive flat panel screen contains layers of glass that can collect condensation,
especially in the following conditions:

e Temperature extremes with high humidity

¢ Rapid changes in humidity, which can occur when you operate the product near water,
such as a sink, pool, kettle or air conditioner ventilator

¢ Direct exposure to sunlight

To evaporate condensation from your interactive flat panel
1. Remove the humidity source from the interactive flat panel, if possible.
2. Adjust the room temperature to normal operating ranges.
3. Turnon the interactive flat panel for 2-3 hours.

If the screen condensation doesn’t evaporate, contact SMART Support
(smarttech.com/contactsupport).

Inspect your interactive flat panel installation frequently to ensure that it remains securely
installed.

¢ Check the mounting location for signs of damage or weakness that can occur over time.

e Check for loose screws, gaps, distortions or other issues that could occur with the
mounting apparatus.

If you find an issue, refer to a professional installer.

To safely remove your interactive flat panel, use two or more professional installers.

IMPORTANT

Follow the instructions included with the floor stand or mounting apparatus.

To remove the interactive flat panel
1. Tum off your interactive flat panel and unplug the power cable from the wall socket.

2. Remove all accessible cables and connectors.
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N WARNING

o Do not move the interactive flat panel by connecting a rope or wire to the handles
on the back. The interactive flat panel can fall and cause personal injury and
product damage.

3. There are two lifting handles on the back of the interactive flat panel, one on each side.
With one person at each end, use one hand each on the handle to support the weight of the
interactive flat panel and the other hand on the upper side to balance it during lifting. The
interactive flat panel weighs about 44.5kb (98 Ib) .
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4. Lift yourinteractive flat panel from its mounting location.

CAUTION

o Do not allow the weight of the interactive flat panel to rest on the colour select
module because it is not designed to support product weight.

o Do not leave the interactive flat panel face up, face down or upside down for an
extended period of time as it could cause permanent damage to the screen.

o Do not place the interactive flat panel on a sloping or unstable trolley, stand or
table, because the interactive flat panel could fall, resulting in injury or severe
product damage.

55



CHAPTER 7

Maintaining your interactive flat panel

Save your original packaging so that you can repack your interactive flat panel with as much of
the original packaging as possible. This packaging was designed with optimal shock and
vibration protection.If your original packaging isn’t available, you can purchase the same
packaging directly from your authorised SMART reseller (smarttech.com/where).

CAUTION

Transport your interactive flat panel only in original or replaced packaging. Transporting your
interactive flat panel without correct packaging voids your warranty and could lead to product
damage.
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Resolving image ISSUES ... 57
Diagnosing blank screen issues using the front control panel lights ..__....................__. 57
Resolving poorimage quality . .......... .. oooiiiiii e 59

Resolving touch control and digital ink issues ... ... 61

ResoIVINg audio ISSUES .. ... . . 64

Resolving remote control ISSUES . . .. ... . 65

Troubleshooting presence detection ... . .. 65

Resolving issues using the SMART Connection Wizard ........... ... ......................... 67

Resolving issues using SMART Board Diagnostics . ... ... .. . i i, 67
Checkingthe camera view .. 67

This chapter provides you with the information necessary to solve simple issues that can occur
with your interactive flat panel.If issues persist, or aren’t covered in this chapter, contact
SMART Support (smarttech.com/contactsupport).

Complete the following steps if your interactive flat panel doesn’t display an image correctly or
doesn’t display any image at all.

Diagnosing blank screen issues using the front control panel lights
Use the following troubleshooting table when your computer is turned on, but you don’'t see an
image on the interactive flat panel screen.

Begin by looking at the interactive flat panel system status light and the power light in the front
control panel.

Power Status Causes Solutions
light light

Off Off The interactive flat panel isn’t Connect your interactive flat panel’s
connected to a power source. power cable to a power outlet (see
page 17).
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Power Status Causes Solutions
light light
The main power switch is off. Turn on the main power switch on the
terminal panel (see page 6).
Solidred Off The interactive flat panel is turned Press the power button on the front
off. control panel or the remote control.
Solid Red The computer is off. Turn on your compulter.
amber or
red
The computer isn’t connectedto  Connect your computer to your
your interactive flat panel. interactive flat panel with the required
cable (see page 16).
The interactive flat panel isn’'t set  Select your computer’s input source
to the correct video input source.  (typically VGA 1, VGA 2 or HDMI 2)
using the remote control.
OR
Press the Power button U until the
Input button B is blue and then press
the Input source button until your
computer’s desktop appears.
Solid Flashing The interactive flat panel is Do not touch the interactive flat
green amber updating firmware. panel.For more information, see page
47.
Solid Flashing The interactive flat panel detects Install SMART software on your
green green a computer, but SMART Product computer (see page 21) or install a
Drivers isn't installed or isn’t SMART GoWire cable (see page 44).
running.(For more information,
see page 61).
Solid Solid The interactive flat panel detects Normal operation.
green green a computer with SMART Product

Drivers installed.
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Resolving poor image quality

Symptom Causes

Solution

Theimageis too The computer’s video
large, too small or resolution settings don’t
doesn’t

match your interactive flat
completely fill the panel’s native resolution.

The interactive flat panel’s native resolution is
1920 x 1080 at 60 Hz.

If your computer can’t support this resolution,
consider one of the following 16:9 resolutions as
an alternative:

screen.
e 1600 x 900
o 1366 x 768
e 1280 x 720
Other resolutions could result in image distortion
or black bars around the desktop.
The screen The computer's video card Turn off or adjust the overscan/underscan
resolution is is underscanning the feature in the video card driver software until the
correct, butthe  image. image fits the screen resolution. Refer to your
) ? computer’s video card help for more information.
image is
surrounded by i NOTE
black bars. If available, select the HDTV setting (ideally

1080p) from your video card driver's advanced
menu. This should provide a pixel-perfect
image for your interactive flat panel.

You have a poor quality
video cable.

1. Replace your video cable with a better
quality video cable.

2. Press the AUTO SET UP button on your
remote control to reset your interactive
flat panel.

OR

Press MENU on the menu control panel
and then select ADJUST > AUTO
SETUP in the on-screen display menu
using the buttons on the menu control
panel.(For more information, see page 69)

You connected two video

cables together.

1. Replace yourtwo cables with one longer
cable.
OR
Move your computer so that it's within a
single cable length of your interactive flat
panel.

2. Press the AUTO SET UP button on your
remote to reset your interactive flat panel.

OR

Press MENU on the menu control panel
and then select ADJUST > AUTO
SETUP in the on-screen display menu
using the buttons on the menu control
panel.(For more information, see page 69)
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Symptom Causes

Solution

The image isn’'t
centred on the

Press the AUTO SET UP button on the remote
control.

OR

screen.
Press MENU on the menu control panel and
then select ADJUST > AUTO SETUP in the
on-screen display menu using the buttons on the
menu control panel.(For more information, see
page 69)

The image is The video connection is Secure the video cable to both your computer

unstable or loose. and your interactive flat panel.

unfocused.

You have a poor quality
video cable

1. Replace your video cable with a better
quality video cable.

2. Pressthe AUTO SET UP button on the
remote control to reset your interactive
flat panel.

OR

Select MENU > ADJUST > AUTO
ADJUST on the menu control panel.(For
more information, see page 69.)

You connected two video
cables together.

1. Replace your two cables with one longer
cable.

OR

Move your computer so that it’'s within a
single cable length of your interactive flat
panel.

2. Press the AUTO SET UP button on your
remote to reset your interactive flat panel.

OR

Press MENU on the menu control panel
and then select ADJUST > AUTO
SETUP in the on-screen display menu
using the buttons on the menu control
panel.(For more information, see page 69)

Your computer’s video
display card is defective.

Connect a different computer to your interactive
flat panel. If this improves the image quality,
consider replacing the video card in the original
computer.

Theimageis too You might have incorrect
light, too dark or  video settings.

has poorimage

quality issues.

Press MENU on the menu control panel and
then select PICTURE > AUTO ADJUST in the
on-screen display menu using the buttons on the
menu control panel.(For more information, see
page 69.)
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Symptom Causes

Solution

Thereis a Animage was displayed
persistent image for too long.
on the screen.

Turn off your interactive flat panel and leave it
turned off for as long as the image was on the
screen.

2 Tip

Use a screen saver to avoid persistent
images.

Other display
quality issues

Press MENU on the menu control panel and
then select SETUP > FACTORY PRESET in
the on-screen display menu using the buttons on
the menu control panel.(For more information,
see page 69.)

Use the following troubleshooting table if you can see your computer desktop on your interactive
flat panel, but you do not have touch control over the desktop.

For more information, see SMART Ink user’s guide for Mac OS X operating system software
(smarttech.com/kb/170192) or SMART Ink user’s guide for Windows operating system

(smarttech.com/kb/170191).

Symptom Causes

Solution

When you touch the screen, The

Update your SMART Product Drivers

no pointer appears andyou SMART Product Drivers (see Updating SMART Product Drivers

can’'t move icons. The on your computer are on page 49).
status light is red. not current.
No USB connection Verify your connections (see page 16).

from the computer to the
interactive flat panel.

Your USB connection ~ Connect the USB to the correct port
doesn’t correspond with  that corresponds to your computer’s
the selected video input. video input.(For more information, see

page 16.)

The SMART MeetingPro  SMART Product Drivers Download and install SMART software

icon EH or the isn't installed.
SMART Notebook icon |- /|

doesn’t appear.

from smarttech.com/downloads.
OR

Connect your computer or laptop to
your interactive flat panel with a
SMART GoWire cable.(For more
information, see page 44.)
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Symptom

Causes

Solution

SMART software isn’t
running.

Open the SMART Product Drivers
folder in your list of programs and then
select SMART Board Tools.

The SMART Board icon [ +]

or SMART Meeting Pro icon
Ef is crossed out in red.

Your computer can’t find
your interactive flat
panel.

Start SMART software and then run the
SMART Connection Wizard’s
troubleshooting procedures.

Eitherthe SMART
Board Diagnostics
window or SMART
Settings is open.

Close the SMART Board Diagnostics
window and the SMART Settings
panel.

Touch interactivity is slow
or sluggish.

Your computer is
running too many
applications.

Close some open applications.

Your computer doesn’t
meet system
requirements.

Upgrade your computer or replace it
with a more powerful computer.

You haven’'t used a USB
2.0 cable to connect
your interactive flat
panel to your computer.

Use a USB 2.0 cable and ensure that it
is connected to a USB 2.0 port on your
compulter.

When you touch the screen
the pointer appears in the
wrong location.

You aren’t touching the
screen at right angles.

For more information, see Touching and
drawing on your SMART Board
interactive whiteboard is Inaccurate
(smarttech.com/kb/131299).

Your interactive flat
panel isn’t orientated.

Orientate your interactive flat
panel.Press the orientate button -=- on
the colour select module and then
follow the on-screen instructions. (For
more information, see page 51.)

Your desktop isn’t
centred on the screen.

Press the AUTO SET UP button on
your remote control to reset your
interactive flat panel.

OR

Press MENU on the menu control panel
and then select ADJUST > AUTO
SETUP in the on-screen display menu
using the buttons on the menu control
panel.(For more information, see page
69)

IMPORTANT

You might have to do this more than
once.
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Symptom

Causes

Solution

An area of the screen
doesn’t respond to your
touch or when you draw
digital ink, the lines are
broken.

Something is blocking
the cameras.

Ensure that nothing is taped to the
screen.

Something is on the
reflective tape channel.

Remove items from the reflective tape
channel.

Your finger or pen is
skipping as you draw.
This is most common on
the upstroke.

Use consistent pressure whilst drawing
digital ink.

Bright lights are
interfering with the
cameras.

Close blinds or shades or dim all
halogen lights and LEDs.

Your cameras require
calibration, possibly due
to temperature change
in the room.

Calibrate your interactive flat panel.
(See page 50.)

You try to erase using
something other than the
eraser, but you draw more
digital ink. One of the colour
select button lights is
flashing.

You're in Locked Ink
mode and all objects are
interpreted as pens.

Press a colour select button that isn’t
flashing to exit Locked Ink mode.

OR

Remove the eraser from the eraser

holder to enable erasing while in Locked
Ink mode.

You try to erase with the
eraser, but you draw more
digital ink. You don’t see a
flashing light on the colour
select module.

You're using an edge of
the eraser.

Increase the contact area of your
eraser.

You're trying to draw digital
ink, but you see a circle
beneath your pointer and
you're erasing digital ink.

Your interactive flat
panel is interpreting an
eraser.

Lift other fingers and the heel of your
hand from the interactive flat panel
whilst you write because the interactive
flat panel is interpreting them as an
eraser.

OR
Use a smaller pointer, such as the pen.
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IMPORTANT

Ensure you can see your computer’'s desktop and have touch control and digital ink before
using this table. If not, resolve those issues before completing the following steps in the table

below.

Symptom

Causes

Solution

Sound doesn’t play
when you play a
sound file.

Your computer is muted.

Turn off the mute setting.

Your computer’'s volume is too low.

Turn up the volume on your
computer.

Your interactive flat panel is muted.

Turn off the mute setting using
the remote control or the front
control panel.

Your interactive flat panel’s volume is
too low.

Use the remote control to turn up
the volume on your interactive
flat panel.

OR

Use the volume control on the
front control panel.

The wrong audio input is selected for
the video input.

Select the correct audio
input.Press AUDIO INPUT on
the remote control.

Your computer uses Mac OS X
operating system software and is not
set to Audio USB output.

Set your computer’s audio output
to USB.(For more information,
see page 41.)
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Y our remote control provides control of your interactive flat panel up to 7m (23') from the front
control panel of your interactive flat panel.

Symptom Causes Solution

The remote control Your interactive Ensure that your interactive flat panel is plugged in
behaves unexpectedly. flat panel isn’t and that the power switch on the bottom terminal
The front control panel receiving power.  panel is in the ON position.(For more information,
power button light is see page 6.)

off.

You are outside Move to within 7m (23’) and a 30° arc of your
the range of the infrared remote control sensor.

infrared remote

control sensor.

The remote control Replace the batteries.(For more information, see
batteries needto  page 26.)
be replaced.

The remote control Contact your authorised SMART reseller
is damaged. (smarttech.com/where) to inquire about a
replacement remote control.

The sensors for presence detection can detect when people are within 5m (16') of the interactive
flat panel and automatically turn on or off the interactive flat panel.

Symptom Causes Solution
Your interactive flat The sensors aren’t enabled. Enable presence
panel isn’t turning on. detection.See Proximity

control settings on page 72.

There isn’t enough of a temperature Reduce the room
difference between the ambient temperature.
temperature and human body

temperature.

You aren’t within 5m (16') of the Move closer to the
interactive flat panel. interactive flat panel or

make bigger motions.

Glass, acrylic or other similar material is Remove the material.
between the person and the sensors.
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Symptom

Causes

Solution

Your interactive flat
panel isn’t turning off
when people have left
the room.

The sensors aren’t enabled.

Enable presence
detection.See Proximity
control settings on page 72.

There isn’t enough of a temperature

Reduce the room

difference between the ambient temperature.
temperature and human body
temperature.

Your interactive flat The re-enable time is too short foryouto Increase the

panel is turning on after
it has been turned off.

exit the room before the sensors start
detecting motion again.

RE-ENABLE TIME
setting.See Proximity
control settings on page 72.

There isn’t a large enough temperature
difference between the ambient
temperature and human body
temperature.

Reduce the room
temperature.

Sunlight is hitting the sensors.

Close any blinds or
shades.

Glass, acrylic or other similar material is
between the person and the sensors.

Remove the material.

Your interactive flat
panel is turning on
when people are not
present.

There’s a sudden temperature change in
the room (humidifier emission, air
conditioning, heating system).

Remove the source of
major temperature
fluctuation.

Sunlight is hitting the sensors.

Close any blinds or

shades.
Your interactive flat Over time, the sensors average the room Increase the AUTO
panel is turning off temperature so people's body POWER OFF setting.See

when people are
present.

temperature becomes part of the ambient
temperature.

Proximity control settings
on page 72.
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You can resolve a variety of issues using the SMART Connection Wizard found in SMART
Settings.

To start the SMART Connection Wizard

1.

Press the Help button on the colour select module.
The Help and Support for Your SMART Board Interactive Whiteboard window opens.
Press Connection Wizard.

The SMART Connection Wizard opens.

H NoTE

You can also access the SMART Connection Wizard by pressing the SMART Board
iconL* | in the notification area (Windows operating systems) or the Dock (Mac OS X
operating system software) and then selecting SMART Settings > Connection
Wizard.

OR

Click the SMART Meeting Pro icon [ in the notification area then select
SMART Settings > Connection Wizard.

3. Select SMART Board 8000 series interactive flat panel and then press Next.

4. Select the option that best describes the issue that you're encountering and follow the on-

screen instructions to troubleshoot your interactive flat panel.

If you touch the interactive flat panel’s surface and nothing happens, or if there is no digital ink or
the ink appears in some locations and not in others, use SMART Board Diagnostics to help
identify and resolve these issues.

IMPORTANT

Do not change diagnostic settings unless asked to do so by SMART Support.

Checking the camera view
If nothing happens when you touch the interactive flat panel’s surface, check to make sure that
nothing is blocking one of the cameras.

To check camera views
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1. Press the SMART Board icon |“] in the notification area (Windows operating systems) or
the Dock (Mac OS X operating system software).

OR
Press the SMART Meeting Pro icon H in the notification area.
2. Press SMART Settings.
SMART Settings opens.
3. Select About Software and Product Support > Tools > Diagnostics.
SMART Board Diagnostics opens.
4. Inthe View menu, select SBX800/SBID8070i/SBID8055i Bar.
The SBX800 group box appears in the SMART Board Diagnostics screen.
5. Press View.
The camera view screen appears.
6. Click Update to display the four camera views. This could take a few moments.

If one of the camera views remains black, the camera is blocked or can’t locate the
reflective tape on the interactive flat panel’s inner frame.

7. Check the camera lens and ensure that nothing is blocking its view and that nothing is
affixed to the interactive surface.
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Adjusting video settings with
the on-screen display menu

Changing settings in the OSD menu
Main menu settings
PictUre SEttiNgS ... . e
Adjustment settings
Audio settings
OSD settings
Setup Settings ..
Proximity control settings

You can access the on-screen display (OSD) menu using either the remote control (see Infrared
remote control buttons on page 28) or the menu control panel on the left side of the interactive flat
panel (see Left side view on page 6).

H NnoTE

You can adjust many of the interactive flat panel screen settings using the remote control.

To change settings in the OSD menu
1. Press the MENU button on the menu control panel or the remote control.
The on-screen menu appears.
Press the up and down arrows to select a menu.
Press SET.

Press the up and down arrows to select the setting that you want to change.

o > 0 DN

Press SET.
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6. Press the right arrow to select the setting that you want to change and enter a setting sub-
menu.

OR
Press the left arrow to decrease or the right arrow to increase the value.
OR
Press the left arrow or right arrow to select a value.
7. Press SET.
8. Tochange another setting in the menu, press the MENU button and then repeat steps 2—4.

9. When you finish changing settings, press the MENU button twice to close the on-screen
display menu.

Picture settings

Menu item Function

PICTURE MODE Sets picture mode to STANDARD, sRGB, SPORT, GAME,
USER, AMBIENT and DYNAMIC.

BRIGHTNESS Adjusts the overall brightness of the image and background.

CONTRAST Adjusts the brightness of the image in relation to the background.
The sRGB picture mode is standard and cannot be changed.

SHARPNESS Adjusts the sharpness of the image.

BLACK LEVEL Adjusts the brightness of the image in relation to the background.
The sRGB picture mode is standard and cannot be changed.

TINT Adjusts the tint of the screen.

COLOUR Adjusts the colour depth of the screen.

COLOUR Sets colour temperature to NORMAL, WARM, USER or COOL.

TEMPERATURE

AMBIENT Adjusts the AMBIENT settings when it is selected in

PICTURE MODE.

NOISE REDUCTION Adjusts the amount of noise reduction on the image.

PICTURE RESET Restores the picture settings to their default values.

Adjustment settings

Menu item Function

AUTO SETUP Sets H Position, V Position and Clock Phase to adjust
automatically when your interactive flat panel is turned on.
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Menu item Function

H POSITION Controls the horizontal position of the image within the screen area.
V POSITION Controls the vertical position of the image within the screen area.
CLOCK Adjusts the width of the image.

PHASE Adjusts the visual noise on the image.

INPUT RESOLUTION Displays the signal at the desired resolution. After selecting this,

use the AUTO SETUP option above.
LONG CABLE COMP Adjusts the video signal for VGA video inputs if a long VGA cable is
used.

ASPECT Sets picture aspect to FULL, NORMAL, TRIM or ZOOM.
ADJUST RESET Restores the adjustment settings to their default values.
Audio settings

Menu item Function

BALANCE Adjust the balance of left and right volume.

TREBLE Adjusts the high frequency sound.

BASS Adjusts the low frequency sound.

LINE OUT Selects FIXED or VARIABLE audio line out.

AUDIO INPUT Sets audio input source to IN1, IN2, IN3, HDMI or TV.

AUDIO RESET Restores the audio settings to their default values.

OSD settings

Menu item Function

LANGUAGE Selects the language used by the OSD menu.

OSD TURN OFF

Turns the OSD menu off after a period of inactivity. The preset
choices are 5-240 seconds.

OSD H-POSITION

Sets the horizontal position of the OSD menu.

OSD V-POSITION

Sets the vertical position of the OSD menu.

INFORMATION OSD

Selects whether the Information OSD menu is displayed.

MONITOR INFO

Displays the interactive flat panel’s model number and serial
number.

CARBON SAVINGS

Displays the estimated carbon saving information in kilograms.

OSD RESET

Restores the OSD settings to their default values.
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Setup settings

Menu item

Function

POWER SAVE

When enabled, and there isn't a video input, the interactive flat
panel displays No Signal for 25 seconds before turning off.

H NOTE

When you connect a DVI video cable, the video card might not
stop sending digital data even if there is no image. In this case,
the interactive flat panel doesn’'t enter Power Save mode.

STANDBY MODE

Lowers power consumption. Select either NORMAL or
ECO STANDBY.

IMPORTANT

When ECO STANDBY mode is enabled, presence detection is
disabled and you cannot wake the computer by touching the
interactive flat panel’s screen.

I NOTE
You can’t use RS-232C Functions in ECO STANDBY mode.

DDC ClI

ENABLE/DISABLE: turns the two-way communication and control
of the interactive flat panel on or off.

SCAN MODE

Sets the scanning mode. Some video formats might require
different modes to display the best image.

PROXIMITY CONTROL

Sets the proximity sensor settings.See Proximity control settings
below.

HEAT STATUS

Displays the FAN, BRIGHTNESS and TEMPERATURE settings.

FAN CONTROL

Sets the cooling fan to protect the interactive flat panel from
overheating.When selected, you can adjust the start temperature of
the cooling fan and its speed.

USB SETTING

Configures the video and touch input.See Configuring the video and
touch input for your SMART Board 8055i interactive flat panel
(smarttech.com/kb/170190).

SETUP PRESET

Restores the setup settings to their default value.

FACTORY RESET

Restores OSD menu options to default values for all items, except
for LANGUAGE.

Proximity control settings

The interactive flat panel has two presence detection sensors on its frame that can detect people
up to 5m (16') away. When the sensors detect people , the interactive flat panel tums on. When

the sensors no longer detect
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The settings for the proximity sensors are a sub-menu in the Setup menu.

Menu item

Function

PROXIMITY

Turns the proximity sensors on the interactive flat panel on or off. If
ECO STANDBY in the Setup menu is enabled, this feature is
disabled.

RE-ENABLE TIME

Sets how long (1-10 minutes) the interactive flat panel will wait
before detecting motion again. The default is 1 minute.

AUTO POWER OFF Sets when (15-240 minutes) the interactive flat panel automatically
turns off. The default is 60 minutes.
BRIGHTNESS Sets the brightness of the welcome screen.

73






Appendix B

Hardware environmental
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is
manufactured, sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
regulations (WEEE directive)

Electrical and electronic equipment and batteries contain substances that can be harmful to the
environment and to human health. The crossed-out wheelie bin symbol indicates that products
should be disposed of in the appropriate recycling stream and not as regular waste.

Restriction of Certain Hazardous Substances
(RoHS directive)

This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2011/65/EU.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas and that reference the European Union’s RoHS directive.

Batteries

The remote contains a CR 2025 lithium battery. Recycle or dispose of batteries properly.

Perchlorate Material
Contains perchlorate material. Special handling may apply.See
ditsc.ca.gov/hazardouswaste/perchlorate.

Packaging

Many countries have regulations restricting the use of certain heavy metals in product
packaging.The packaging used by SMART Technologies to send products complies with
applicable packaging laws.
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Adjust settings See also Adjustment
settings
Adjustment settings 70
audio files
playing 41
Audio settings 71

batteries 75
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computer 1 video input 17
computer 2 video input 19
connecting a peripheral device 20
connections 7
speaker wire connections 8

calibration 50
cleaning
camera windows 53
proximity sensors 52
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computer 1 17
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guest laptop 43
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digital ink
drawing 31
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European Union regulations 75
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next page 38
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previous page 39
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rotating 37
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GoWire See SMART GoWire cable

HDMI connections 6-7

Ink See SMART Ink
Ink Aware See SMART Ink
inside terminal panel
computer 1 USB input 17
computer 2 USB input 19
connections 8
room control system 15
installation
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computer 2 connection 18
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right-clicking 35
RoHS directive 75

laptop
computer 2 connection 18
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SMART GoWire cable 44
SMART Ink 30
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install 14
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on-screen display See OSD transportation 56
on-screen display menu settings See OSD
Settings
orientation
about 51 updating
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changing settings 69 SMART Product Drivers 49
OSD settings 71 SMART software 47
USB port
disable 19
packaging 75
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replacing 51
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